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It seems that you can’t turn on the news

be unable to comply. Ortho2 Network Engineer Rachel Gildersleeve

without hearing about a medical center

explains this further on page 4.

or small business being targeted for a

A second, but equally important, area of focus should be your

cybercrime. In fact, 43% of cyber attacks are

backups. If you’re using Edge Cloud, we have you covered. However,

targeted at small businesses, who frequently

Ortho2 has helped three ViewPoint customers recently who

have a minimal security infrastructure1. But

thought they had stable backups only to realize after a virus attack

what can you do? One thing is to make sure

or equipment malfunction that their backups were not working

your operating system is current.

properly. This creates a terrible situation for your practice, and hours

You may have heard Microsoft is ending

upon hours of work IF the data can even be recovered. If you need

support for Windows 7 in January 2020. After this support ends,

a refresher of what your backup routine should look like, visit our

you can continue to use the operating system, but at your own risk,

website to learn more www.ortho2.com > Support & Learning >

and without updates and patches from Microsoft. This makes you

Documentation > General > The Ultimate Backup Routine.

vulnerable to computer viruses and other malware.

Don’t wait until it’s too late to plan your move to a new version

An outdated operating system can also cause compliance problems

of Windows or confirm a data backup is working. Make sure your

with HIPAA regulations. HIPAA states that you must implement

patient and practice information is protected today! If you have

procedures for guarding against, detecting, and reporting malicious

any questions, contact the Ortho2 Network Engineering Team at

software. Additionally, if you accept payment by credit card, you

engineering@ortho2.com or 800.346.4504.

must also comply with PCI standards. PCI Data Security Standards

Amy Schmidt

(PCI DSS) 6.1 require you to “ensure all system components and
software have the latest vendor-supplied security patches installed.”

Amy Schmidt, Ortho2 President

Once Microsoft stops releasing these patches and updates, you will
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2019 AAO WRAP UP

Thank you to everyone
who stopped by our
booth at the AAO!
We would like to thank the following staff who
worked hard in the Ortho2 booth at the AAO
and contributed to our success!
Laura Force – TDR Specialists in Orthodontics
Gina Good – Good Orthodontics
Jodi Miller – Certified Ortho2 Training Specialist

COME VISIT US AT THESE FALL MEETINGS
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Great Lakes Society of Orthodontists/
Middle Atlantic Society of Orthodontists

September 13–15, 2019

Canadian Association of Orthodontists

September 20–21, 2019

Northeastern Society of Orthodontists

September 27–28, 2019

Pacific Coast Society of Orthodontists/
Rocky Mountain Society of Orthodontists

October 3–5, 2019
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ORTHO2 EQUIPMENT NEEDS

No one would argue that having a professional and proficient

reaches its end of life in January of 2020. This means that

As previously mentioned heavy use computers need more

staff is key to the success of an orthodontic office. What

Microsoft will stop releasing security updates and will no

resources. Computers in the clinic that are just used for

is also important, is having reliable computers. Unless an

longer release fixes for when other software stops working

treatment notes and looking at pictures have a little more

office is proactive about their computers and already have

with Windows 7.

flexibility. However, the computer that imports pictures

an upgrade schedule in place, it’s easy for them to get
overlooked. The older the machine is, the less reliable it
is, and the more likely something can go wrong. Especially
without regular maintenance. This almost always leads to
frustrating situations. Soon it seems like nothing in the
office is working, computers are constantly going down,
and the whole
office is running
unbearably
slow. One of the
most frustrating
situations for
staff members
is having an

We recommend making a plan as soon as possible to start
replacing Windows 7 computers. They will eventually become

Do I need desktops or laptops? What are the differences

just as much a security risk to your internal network as XP

between them?

computers are now. Practices need to take every precaution
to protect themselves and patient information. Making sure
all computers are up to date and secure is a good start. If

Practices need to take every precaution to
protect themselves and patient information.
Making sure all computers are up to date
and secure is a good start.

impatient parent

you need assistance
in determining which
operation system
you have, please
contact the Network

There are two major differences between laptops and
desktops that would affect how staff function in the office.
One is mobility. I have seen clinic staff work with laptops
assigned to each assistant and I have seen each chair have
a computer assigned to it. It really depends how your clinic
staff function. The specs are the same for desktops and
laptops so really it’s what your staff prefer.

I want to get rid of my server now that I’m on Edge
Cloud, but it has all my 3D scans and images, do I still
need a server for them?
No, really you just need storage. Network Attached Storage
devices work great for storing large amounts of data that
you need to access over you network.
Once you upgrade it is so important to take care of your
workstations. The most important consideration to take
in keeping computers running well and running longer is
personal responsibility. Don’t open email attachments you
don’t recognize, practice suitable for work Internet surfing,
and don’t give out your passwords. You will also want to
keep up with Windows Updates, reboot your computer once

Engineering Team at

The other difference is Internet speed. Wired Internet

a week, and run regular maintenance with the help of your

the contact information

is going to be faster and more consistent than wireless.

local IT professional or Ortho2’s Network Engineering Team.

on the next page.

Another thing to consider is that these days many laptops
on the market do not have an Ethernet port.

New technology can make your practice more profitable and

standing in front of them waiting to schedule or make a

This can be a daunting task and we at Ortho2 get questions

payment and their computer freezes.

all the time from customers about replacing workstations.

If you go the laptop route, I would recommend trying to find

your practice runs. Technology moves quickly and it can be

Here are a few of the most common questions asked:

a model with a solid state drive (SSD). Laptops get moved

hard to keep up with but it’s nothing to fear. At least until

around the office more than desktops and are more likely to

the machines become self-aware. Then we have a problem.

We recommend that computers should be replaced every 3-5
years depending on how much staff utilize them. Computers
that get the most use, such as front desk machines, will need
to be replaced more frequently. Another computer that

What exactly are our recommended specifications?
•

can only have around 4GB of RAM which is not sufficient

room computer. With new 3D modeling technology and

for Edge Cloud or ViewPoint.

animation videos, patients now have the opportunity to see
details about their treatment that they couldn’t before. This

Windows 10 Professional or Enterprise, 64-bit. 64-bit is
important mainly for RAM capabilities. 32-bit computers

commonly requires additional maintenance is the consult

•

Intel Quad Core processors, later generation i5s and

exciting new technology requires newer and better hardware.

the new i7s are great. If you’re really looking for some

In many cases these computers end up being the most high-

speed, there are new Intel i9 processors, but they come

tech of any computer in the office. This includes newer i7

with a hefty price tag.

quad core processors, dedicated top tier graphics cards, solid
state drives, and larger monitors. This is what Ortho2 would

•

be the recommended specifications for heavy use computers

•

like front desk workstations.
It seems like not too long ago we were telling customers
to upgrade their Windows XP computers. We’ve come to
that point again, but this time with Windows 7. Windows 7

8 GB of RAM minimum. 16 GB in the front desk
workstations is optimal.

consider to be our optimal specifications. These would also
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should have a good graphics card and 8 GB of RAM.

Having a physical keyboard is helpful in an office setting.

1 GB dedicated video memory. NVIDIA GeForce
graphics cards work great

•

1920x1080 for dedicated monitors, 1600x900 for laptops

I recommend getting as close to these specs as possible.

instill confidence in your patients when they see how well

get dropped or damaged. Since SSDs have no moving parts
they are less likely to get damaged if dropped.
One last thing to remember is that laptop screens are
limited in size and resolution. The smaller the screen and
lower the resolution the more difficult it will be to use both
Edge Cloud and ViewPoint.
Does my sign-in computer need to meet these
specifications?
Not necessarily. More often now we see offices using tablets
for patient sign-in. Surface Pros are great, but any tablet
with a Windows OS will work.
Would a tablet be a good idea for a workstation?
Not in my experience. While they are an excellent option
for patient sign-in and for patients to fill out Health History
Forms, they are not as practical as laptops or desktops.

About the Author
Rachel Gildersleeve works in the
Network Engineering Department and
has worked at Ortho2 for seven years. In
her spare time she enjoys spending
time with her husband, Sean, and their
two dogs, cooking, and watching the
Iowa State Cyclones.
Contact Info: 800.346.4504 • engineering@ortho2.com
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GET YOUR POSTURE STRAIGHT

“Know your powers. The
power of your words, your
silence, your mind, your
body language and your
body itself. Control them.”
Sonya Teclai

Leaders understand the importance of posture. There is
more to posture than sitting tall or standing up straight.
Posture also relates to a frame of mind or attitude when
communicating with our customers.

Posture – Two Differing Attitudes
There are two primary postures used throughout the day:
deference and guidance.
During the day a leader must toggle between these
deferring and guiding attitudes. And while everyone on the
team must understand and use the proper posture, there
is no one who needs it more critically than your front office
team and those communicating via phone.
Why is this?
Phone conversations lack the visible cues of body language,
but even so, a caller perceives posture and attitude over the
phone. So let’s empower these valuable leaders who are on
the phone.

Deference
A dictionary definition says that deference is, “respectful
submission or yielding to the judgment, opinion, or will of
another.”

orthodontic marketing has changed as a result of a trend

and no marketing training. In the past, this didn’t matter.

This increase in competition has transformed the way

Orthodontic practices could perform limited marketing and

orthodontic practices design, implement, and track their

still be very successful. However new competition demands

referral marketing programs. Is your practice experiencing

effective marketing. We now advise practices to create

the challenges of increased competition? If so, you’ll need

focused marketing in five areas—patients, parents, social

to understand where it comes from and how to take the first

media, referring doctors, and community.

steps toward addressing it.

Keep in mind that there are two factors that determine
the success of these programs. The first one is strategies.

you at [Option A] or [Option B]. Which one works best

We are at the beginning of a rapid increase in competition

Selecting strategies for each focus area is critical. People

for you?”

that will affect referrals in orthodontic practices. New sources

react to a multitude of different types of marketing

of competition include:

messages, branding, outreach, fun, excitement, and

Advising of the best option with, “My recommendation

•

emergence of aligners

Providing awareness of consequences by saying, “Yes,

has made it easier for

we can look for a late appointment; that will impact

general dentists to

treatment time. Do you wish for me to continue to

perform some level of

look for the last appointment of the day or explore an

Keeping a high level of marketing
at all times is now essential for
every orthodontic practice.

orthodontics. And while

option closer to what the doctor recommended?”

The Switcheroo
All too often there is a switcheroo, and team members
are unaware. A majority of those on the phone self-report

General Dentists. The

•

Ask permission to place someone on hold and say,
“May I place you on a brief hold?”

•

Wrap up a conversation by asking, “Is there anything
else I can do for you?”

Guidance
Guidance is providing direction, leadership, and advice.
Even in an elective-based business, it is still appropriate to
guide. We politely guide. Examples of when to do so are:
•

Setting appointments and saying, “The doctor can see

About the Author
Amy Demas, MBA, DTM, DFSS is the
President of Communicate Excellence,
a consulting firm specializing in the
communication and phone skills of your
front office to improve the customer
experience and case acceptance.
Contact Info: 203.266.2881 • www.communicateexcellence.com

synergized marketing result.

Having one brilliant strategy in each category will not get

Orthodontic Retail. We predict that more than 1,000

with the stores. These stores provide diagnosis and sell
orthodontic treatment performed outside of the stores,
at lower fees.
•

combined in order to create a

increasing each year.

orthodontic companies or practices that are networked

Posture continued on page 15

different categories and

have a specific number of strategies in each category.

five years. They will create a high level of visibility for

•

to be selected in all of these

The other factor is quantity. In referral marketing you must

guidance.

differently.

marketing strategies need

performed annually, treatment by general dentists is

appropriate for our offices. Examples of when this is used is

My evaluation of tens-of-thousands of calls verifies

energy. Your practice’s

they still represent the minority of orthodontic cases

retail orthodontic stores will open within the next

Offer a greeting and say, “How may I help you?”

Most orthodontists have limited marketing programs

that I refer to as the orthodontic competition explosion.

100% compliance with the proper posture of deference and

•

Strategies and Quantity

Competition Trends

is to…”
•

This is the third installment in a series of articles on how

Simply put, it is being courteous and respectful. This is
when we:
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•

NEW DIRECTIONS IN ORTHODONTIC
MARKETING PART 3

DSOs. Large DSOs and gradually smaller group
practices are incorporating orthodontic care into their
offices.

the desired result. However, when you combine multiple
strategies in each category, many of which integrate with
other strategies, the results can be powerful. For example,
an orthodontic practice that starts a community food drive
Marketing Strategies continued on page 15

About the Author
Roger P. Levin, DDS is a third-generation
general dentist and the Founder and
CEO of Levin Group, Inc., a dental

These are the largest emerging trends that are leading

management consulting firm that has

to the orthodontic competition explosion. While parents

worked with more than 26,000 dentists.

and patients will continue to seek orthodontic care from

He is an internationally-known dental

orthodontists, the level of competition continues to increase

practice management speaker who has

and orthodontists will need to radically change their referral

written many books and articles.

marketing strategy in order to remain successful.

Contact Info: 888.973.0000 • levingroup.com/ortho
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USING KEIRSEY TEMPERAMENT THEORY TO SELECT, TRAIN,
COMMMUNICATE, AND CARE FOR YOUR TEAM
In the children’s book, Who is the Beast? by Keith Baker,

with fundamentally diverse ideas, who see the world very

a desire to serve and preserve our communities. They

(leads), contending (wins), collaborating (includes), or

animals of the jungle voice traits of a young tiger as he

differently from each other. It is why we react differently to

have a natural talent for keeping business running

accommodating (considers).

mysteriously moves through the rain forest; “I see his

different situations, respond emotionally to each other, and

smoothly. Using their logistical intelligence, Guardians

stripes, yellow and black…his legs, sure and strong… and,

why we handle matters of crisis in various ways.

excel in supervision, planning, teamwork, organization,

his eyes, green and round.” Yet, the surprise ending reveals
a gentle lesson of how we can celebrate our similarities and
respect each other’s differences.

There are, however, different schools of thought on

Elizabeth, President Jimmy Carter, Barbara Walters,

personality. Sigmund Freud (neurologist) believed that

Vince Lombardi, Warren Buffet, and Rosa Parks.

physical pleasure was the basic motive for all human beings,
3.

Idealist. These enthusiastic, intuitive, kind-hearted,

of the team, one can better select, train, communicate,
and care for their team members. In doing so, doctors
can establish and sustain the values and vision for the
practice, as well as develop a culture that reflects a sense-of-

People’s uniqueness is

while Harry Sullivan (psychiatrist/

an expression of natural

psychoanalyst) believed social

authentic, spiritual, and inspirational personalities

diversity. Just like a pumpkin

status was the real motivator.

encompass 15% of the world population. With a

seed cannot grow into a

Abraham Maslow (psychologist)

high intelligence in diplomacy, Idealists have a talent

tree, nor can people trade

felt that self-actualization and

for written and oral communication. They provide

their true temperament

growth was the basis of human

harmony in the workplace for they combine fluency with

and character for that of

behavior, while Alfred Adler

language and sensitivity to individual and group needs.

someone else’s.

(physician/psychotherapist)

Idealists use their interpersonal skills as managers,

maintained that people strived

mediators, counselors, teachers, and public speakers.

for superiority and supremacy.

You may recognize an Idealist in Oprah Winfrey, Mother

Keirsey is the world’s most widely used personality

Keirsey, studied all these

Theresa, Ghandi, C.S. Lewis, Bono, Maria Shriver, and

assessment. More than 100 million individuals from

theories and determined that all

Princess Diana.

170+ countries have taken the assessment. The Keirsey

Why do dogs bury bones?
Why do beavers build dams?
Why do hens sit on eggs?
And, why are lions social

four quests are part of human

while tigers are solitary in

nature. In fact, they are the

nature? Just like animals

core pursuits of each of the four

differ, we too differ from
each other in fundamental
ways. So, why do people attempt to reshape others to
reflect their own personality?
According to Dr. David Keirsey, psychologist and author,
“There is much to be gained by appreciating differences,

temperaments that have been
repeatedly observed in human and animal behavior for over
two thousand years. The Keirsey four temperaments are
described as:
1.

and much to be lost by ignoring them or condemning them.
But the first step toward seeing others as distinct from
yourself is to become better acquainted with your own

4.

Rational. Only 10% of the world population is made
up of these masterminds. They are problem solvers,
focused, independent, even-tempered, and they trust
logic. Rationals are highly intelligent in strategy. Their

Much like Who is the Beast? presents a timeless message to
young readers, the Keirsey Temperament theory gives adults
in the workplace a true understanding of each other.

More on Keirsey
Keirsey’s mission is to change the world by helping people
understand each other.

assessment is used by the U.S. Government, all branches of
the U.S. military, academic institutions, 75% of the Fortune
500 companies, numerous global consulting firms, social
enterprises, and faith-based organizations.
Sources

advances in technology and medicine for they are

Keirsey (2016). Learn About Your Temperaments
in the Workplace. CA: Author.

problem solvers of complex systems. Being of curious
nature, Rationals can analyze any system that makes

They are dreamers, fun-loving, optimistic, spontaneous,

up the world around us. They include Bill Gates, Hillary

creative, and impulsive. Artisans have a natural ability

Clinton, Steve Jobs, Albert Einstein, Lee Kuan Yew,

to excel in the arts. Not only fine arts or performing

President Barrack Obama, and Walt Disney.

and industrial arts. They are also excellent in business,

belonging for both their employees and patients.

expertise in knowledge have contributed to many

Artisan. Artisans make up 30% of the world population.

arts, but also athletic, military, political, mechanical,

traits of character. “

Trying to determine which temperament is best is like trying
to determine which color of the rainbow is the finest, for

Keirsey, D. (1998). Please Understand Me, II. Temperament,
Character, Intelligence. CA. Prometheus Nemesis Book Company

About the Author
Christine Townsend served in the field of
education for over 15 years before joining

According to Keirsey, there are two sides to personality:

for their intelligence in tactics provides them a flair for

temperament (nature) and character (developed).

the “art of the deal.” Artisans are leaders like President

Temperament is born within us. It is the reason dogs hide

Bill Clinton, Madonna, Stephen Spielberg, President

Under the four temperament resides 16 personalities that

to her career as a Treatment Coordinator,

bones, beavers dam up streams, and why birds form a

Donald Trump, Meryl Streep, and Michael Jordan.

are made up of our temperament and character combined.

she is also a Keirsey Temperament Certified

In looking at the interactive roles people play out in their

Professional, and a Training Specialist with

social context, one can determine which team members

Debbie Best Consulting Network.

clutch of eggs. It is also why some people are expressive
while others are reserved. Character is developed by our
upbringing, experiences, genetics, and education. Together,
they build our personality. We are unique individuals
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and maintenance. Some famous Guardians are Queen

By investing time to understand oneself and each member

2.

Guardian. 45% of the world population is made up
of these genuine and hard-working people. They are
dependable, loyal, focused, cautious, and responsible.
Guardians are the foundation of society and they have

they all play a perspective role in society.

Marcel Orthodontics in 2007. In addition

are naturally more directive and which ones are more
informative, as well as which ones are more pre-empting

Contact Info: 925.413.8339 • christinestownsend@gmail.com
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Information about the people of Ortho2 and the resources available to you as a member

FREE WEBINARS

ORTHO2 ANNIVERSARIES

We offer you free, online webinars each month throughout the year on various topics. It’s a great solution for training new

Congratulations to these Ortho2 staff members who celebrated anniversaries during the second quarter of 2019.

users, refreshing experienced users, or learning about new features. Webinars are available online at www.ortho2.com >
Meetings and Webinars > Ortho2 Webinars. Find the topic for the month and click the link to view the webinar at your
convenience.

Visual Tags consist of a user-defined shape and color
combination that can be used to “tag” a patient and/or

doctor’s involvement with patient appointments. We will

and where it is visible once in use.

settings, and using the light bar.

Gabrielle Bradford

Twenty-Seven Years

You can use the tooth chart to record and review the state
up and options to get started, in addition to using the tooth
chart features.

You can use the Light Bar widget to monitor the

Michael Lasley

Thirteen Years
Lindsey Spieker

Kim Barker

Brooke Hawke

Eight Years
Sean Gildersleeve

Two Years

Clarence Bryan

Michelle Haupt

Joe Skluzacek

Jess Huennekens

Eighteen Years
Ron Benifiel

Seven Years

Cathie Raley

Elizabeth Nordeen

One Year
Izzy Austin
Sam Rubenstein

Seventeen Years
Barb Williams

CAREER MILESTONES AND DEVELOPMENT

CUSTOMER ALERT

Zak Clipsham and Joe Randazzo joined the Software Support Team as Software Support Representatives on March 11. Zak

Have you noticed the customer alerts on our website? Probably not, as they aren’t there that

recently graduated from Iowa State University with a degree in Exercise Science. Joe also recently graduated from ISU with a

often. But if there ever is an issue with one of our products, you will see an alert letting you

degree in Software Engineering. Please join us in welcoming Zak and Joe to the Ortho2 Team!

know what is going on. Once things have been resolved, the alert will go away. You won’t see

Matt Hilleman, Ortho2 Vice President, Development, celebrated his 25th anniversary on March 24. The celebration included

Three Years

Twenty-Four Years

September – Edge: Tooth Chart

and health of your patients’ teeth. We will demonstrate set
August – ViewPoint: Light Bar Widget

Five Years

Micky Augustin

demonstrate how to access the widget, choosing your

responsible party record for classification or subgrouping
purposes. We will demonstrate how to activate this feature

Fifteen Years

Ken Hoffmeier
Craig Scholz

Upcoming Webinar Topics
July – Edge: Visual Tags

Twenty-Nine Years

these often, but they are a good source of information when things do arise.

chips, salsa, his favorite beer, and stories from the past. Congratulations on this accomplishment, Matt!

ON A PERSONAL NOTE
Brooke Milligan, Ortho2 Multimedia Marketing Coordinator, married Tyler Hawke on
December 28, 2018. Congratulations! We wish you many years of wedded bliss!
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Information about the people of Ortho2 and the resources available to you as a member

MEET THE TEAM - NETWORK ENGINEERING

Ron Benifiel
My role model: My parents were who supported and influenced me the most in my life

Last quarter we introduced you to the Network Engineers.

Lowell Davis

I can’t go a day without: My wife and our family, listening to music, enjoying my pets

This quarter we follow up with the remaining members of

Vacation destination: Somewhere

What are you listening to right now? Classic rock

the Network Engineering Team: Lowell Davis, Network

tropical but without huge crowds

Favorites

Engineering Manager; Mike Vest, Network Administrator; and

Three people I would like to have

Software Program: PC Games

Ron Benifiel, Repair Technician/System Builder.

dinner with: Ron Santo (I’d like to tell

Movie: Science Fiction/ Mysteries/Horror

him what he missed with the 2016

Book: Anything science fiction/mystery/suspense or Horror

World Series), Gordon Ramsay, Ron

Phone App: Instagram Facebook/Messenger/Netflix/Music and News apps

What do you really do here at Ortho2?
LD: I’m the Network Engineering Manager. I’ve also spent

Paul

time as a software support rep, on-site trainer, and in

My role model: I don’t have one, I just

advanced support.
MV: I work with all the company’s computer network
and server infrastructure, making network systems for all
employees to use. Also working with customers on unique
problems.
RB: I do all repairs on equipment, fulfill hardware orders, and

try to be the best person I can be
I can’t go a day without: Coffee
What are you listening to right now? The Ron Burgundy
Podcast

SERVICE EXCELLENCE
We invite you to recognize Ortho2 employees by sending Extra Mile cards. A card is included in this newsletter, or you may
send cards online from the Contact Us page of our website. Our goal is to uphold our tradition of excellence in customer

Favorites

service, and with our Extra Mile program, you can let our employees know when you appreciate their extra effort. We

Team: Chicago Cubs
Software Program: Evernote

manage the loaner equipment inventory.

Movie: Clerks

What’s fun/what do you enjoy about your current job?

Phone App: Ring. I like knowing if my kid is taking the dog out

LD: Leading the most eclectic group of professionals while

when I ask him to.

Book: The Puppy Who Lost His Way by Chrissy Taylor

encourage you to send an Extra Mile card whenever an Ortho2 employee goes the extra mile for you. The recognition is
valued by the recipient and is acknowledged by our management team. We continue to look for better ways to serve you.
Thank you for helping us recognize excellence.

JOIN OUR EMAIL LIST

learning about flat Earth, the best condiments around Ames,

Mike Vest

and hearing a wide arrange of cover songs daily from Iowa’s

Vacation destination: Highlands and

karaoke king.

New York

Here’s an exciting opportunity to enhance your success with Ortho2 products and services and be among the first to get

Three people I would like to have

news. We have an email communication program which includes money saving discounts and incentives, overviews of new

dinner with: Albert Einstein, Martin

features, productivity tips, meeting updates, periodic optional feedback surveys, and more. We think you will like getting

Luther King, Jr., Abraham Lincoln

these messages.

MV: I enjoy diagnosing complicated problems and
implementing new ideas.
RB: I enjoy building new systems for our customers as well

My role model: Any legit peaceful

as troubleshooting and repairing customers’ equipment in a

person

timely manner.

I can’t go a day without: Caffeine and

Furthermore, we believe associate doctors and members of your staff will benefit from the productivity and usage tips, and
we would encourage them to sign up as well.

a smile

To register email addresses for this program, simply visit the Register for Updates section of our website,

What are you listening to right now? Journey, Queen, Lady

www.ortho2.com > Resources > Register for Updates. As mentioned above, multiple individuals from your office can

LD: The team’s longevity and experience in the industry

Gaga, Elton John, Beatles

register. Even if we already have your email address, it won’t hurt to register here, and it will guarantee your inclusion in this

allows them to give the best advice on upgrades and

Favorites

program.

maintenance for your practice.

Team: Chicago Cubs

What do you want our users to know about what you do?

MV: I strive to keep things working and find the solution.

Software Program: Visual Studio and Photoshop
Movie: Star Wars

RB: I’ve always liked the challenge of how things work and

Book: I’m not a huge book reader but I did enjoy reading Dr.

fixing them when they’re broken.

Seuss to my grandkids.

And of course, if you or any of your staff ever decide that the messages are not of interest, you can simply use the opt-out
option provided on each message.

Phone App: Texting
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Information about the people of Ortho2 and the resources available to you as a member

HELP US HELP YOU

Posture continued from page 6
A classic example of the switcheroo is when callers get told

feedback. Consider this with a caveat. Giving feedback in a

Please be prepared to provide your customer number, practice name, and office location when you call our support teams

they will be put on hold and then broadly asked when they

way that encourages change is not always in the wheelhouse

for assistance. You can find your customer number in Edge Cloud by clicking File > About. If you use ViewPoint, you will

want to come in for an appointment as if you have 24/7

of the skills of most doctors and managers.

find your customer number by clicking the Help menu and choosing About. Please be sure to provide this information—and

availability.

repeat your phone number—when leaving a phone message requesting support. Having clear information helps us serve
you more quickly.

Finally, consider hiring a team coach for communication

Oh no!

training.

The Solution
First, talk with your team about the difference between

CHAT SUPPORT

deference and guidance. Rehearse the examples above.

Do you need to call into our Support Team for a question, but it’s difficult to wait on hold, even for a few minutes? Ortho2

Second, evaluate phone recordings and provide appropriate

has you covered! Use our chat support to get in contact with us. When you use the chat support feature, you will be added
to the same queue as phone calls. You can choose to chat with the Software Support, New Customer Care, or Network
Engineering Teams.
In Edge Cloud, you can find links to chat support through the Help menu. In ViewPoint version 11, it is the bottom right Help
button in the Daily Activities menu.
So drop us a line when you are in a pinch! We are here to help you in whatever way is most convenient for you.

Marketing Strategies continued from page 7
with its patients, can market it on social media, and set up a

In this new era of increasing competition, lackluster referral

contest with rewards for people who donate the food. This

marketing programs just won’t work for practices that want

marketing activity has actually touched three key areas—

success. Keeping a high level of marketing at all times is

community, patients, and social media. This is just one of

now essential for every orthodontic practice. By combining

many examples of how referral marketing needs to work

strategies and quantity, any orthodontic practice can

today.

increase referrals.

CONTACT US
Phone

Email

Social Media

800.678.4644 (Sales)

accounting@ortho2.com

www.facebook.com/ortho2

800.346.4504 (Support)

admin@ortho2.com

www.youtube.com/ortho2systems

engineering@ortho2.com

www.twitter.com/ortho2systems

ideas@ortho2.com

www.linkedin.com/company/ortho2

orders@ortho2.com

www.instagram.com/ortho2systems

ortho2support@ortho2.com

http://blog.ortho2.com

sales@ortho2.com

www.ortho2.uservoice.com

Website
www.ortho2.com
Newsletter Submissions
editor@ortho2.com

ugm@ortho2.com

Users Group Meeting
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